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This handout contains screen shots of confidential and proprietary information 
for view only. It shall not be copied or shared for anything other than its intended 
purpose as a training device for the County of San Diego, Mental Health 
management Information System. 
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CONFIDENTIALITY 
 

HIPAA regulations mandate that all client information be treated confidentially. 
 

Access to CCBH is based on your position and your job classification. You will have the 
access you need to complete your job duties. This can include access to clients in your 
Unit/SubUnit or may include full client look up. Remember – with more access comes 
greater responsibility regarding confidentiality! 

 
You are not to share passwords with other staff. The Summary of Policy you signed 
before receiving your access to CCBH included your agreement to this directive. You 
are still responsible if someone with whom you have shared your password violates 
confidentiality! 

 
The MIS unit investigates any suspicions regarding sharing of passwords. 
Consequences are up to, and may include termination. 

 
Do not open any active client charts unless instructed to do so, or if it is required to 
complete your job duties. “Surfing” clients is a blatant breach of confidentiality. 

 
Remember you are personally and legally responsible for maintaining confidentiality. 
Take it seriously. 

 
Do not leave your computer unlocked with client data on the screen for others to access 
or view while you are away from your desk. Lock your CCBH session before leaving 
your computer. 

 
When printing, make sure you are printing to a confidential printer, and pick up your 
paperwork quickly. Leaving printed Protected Health Information (PHI) out is also a 
confidentiality violation. 

 
 

Play it safe – keep in mind how you would want your own PHI handled! 
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CCBH SOFTWARE BASICS 
 

o CCBH IS ACCESSED THROUGH CITRIX (Cerner): 
Go to https://cosdca.cernerworks.com 
(Save this to your favorites or create a shortcut for your desktop) 

o “TAB TO TRAVEL”: Get in the habit of using your “Tab” key. Using the “Tab” 
assures that you are directed to all required fields and that the information you 
input is actually captured by the system. 

 
RIGHT CLICK: When there is no obvious way to add information into a field, right click in the space to view your options. 

 
FILTERS/RADIO BUTTONS: Check these first and make sure they are on “all” when searching the database. 

o MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end 
of a field, it means there is a “Search Screen” that you can pull up to find 
information for that field. You do not have to use them, but they are there if you 
need them. 
REQUIRED FIELDS are in red or blue: They must be filled-in to save and final approve information. 

o OPTIONAL FIELDS are in white: Information may be added, but is not required 
to final approve the Assessment. Keep in mind – just because you have 
completed all the fields required to final approve the form, does not mean 
you have completed a thorough clinical assessment. Documentation 
standards have not changed. 

o CLOSED FIELDS are in gray: Nothing can be added in these fields. 
o CASE SENSITIVE: 

o Passwords – if you receive an error message for “Invalid Password”, check to 
make sure you are using the appropriate upper and lower case letters when 
typing. After a third attempt with an invalid password, the system will lock 
your session and will require contacting the Optum Support Desk (1-800-834- 
3792) to unlock it. 

o Table Searches – when searching within a table, be aware that descriptions 
or IDs are case sensitive. If you do not use the correct upper or upper and 
lower case entry, the search will not take you to the desired table value. 

o MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access 
the same information in multiple ways. We have included screenshots and 
directions in this document to guide you through the system. 

o 

o 

o 
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any time you step away from your computer. This packet explains the various 
ways to lock your session. 

 
 

Note: Locking your session is best used for short times away from your computer. 
CCBH will log you out after 60 minutes. There is a chance of losing work that has not 
been final approved or saved if CCBH logs you off. 

 
o WHEN YOU GO BACK TO YOUR PROGRAM: You are learning how to enter 

assessments in the “SDC Train CCBH” environment during this training, which 
is for practice purposes only. It is important to enter all of your assessment 
information in the “SDC Live CCBH” environment when you return to your 
program. 

 
• For password resets/menu issues: Call the Optum Support Desk. You may also 

call if you need your “SDC Live CCBH” environment password or menu set up. 
Their contact information is: 

 

 
 

Reminder: 

Optum Support Desk 
1-800-834-3792 

 

Menu access is set according to job title/functions. The menus you have at your 
program may look different than menus shown in the screen shots in this 
packet. 
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CCBH SPEAK 
 
 

Assessment In CCBH, anything that is not a Client Plan or a Progress Note is 
considered an “Assessment.” So, in CCBH Speak, forms such as the 
Discharge Summary, Outcome Forms, and Demographic Form are 
considered “Assessments” as well as the actual clinical assessment 
forms. 

  

Clinician’s 
Homepage 

A “page” that provides the Clinical servers at each open assignment to 
view client/s and client information for the identified caseload in one 
screen. This includes client look up, caseload listing, appointments, 
task/s to do, notifications, and other client information present in the 
EHR. 

Collateral 
Server 

Co-Staff providing a service (i.e. co-facilitator). Used when more than 
one staff is providing a service to the same client, on the same date 
and at the same time as server. 

Demographic A client is entered into the EHR by the completion and final approval of 
the demographic form. A client may not be opened to 
assignment/program unless the demographic form is entered, 
completed, and final approved. 

Final Approve Locks the completed 
assessments. 

assessment. Prevents editing/deletion of 

SAI – Single 
Accountable 
Individual 

Primary server identified based on primary unit program set up. This 
staff will be listed as the primary contact for the client in the system of 
care for purposes of coordination of care. 

  

Service Code Procedure Code. The code data entered into the EHR for the purpose 
of claiming a service activity. 

Server Staff providing a service activity. 

Unit The Physical Location of a program, or legal entity. 
Sub-Unit The specialized set of services offered within a Unit (i.e. population, 

funding sources, etc.). 
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PASSWORD CHANGES 
Citrix (Cerner) Password 
The first Citrix (Cerner) password you ever receive is considered a temporary password. 
For security reasons, you will be prompted to change your password on your first log in. 
To do so after the initial login, click “Change Password” when first logging in to Citrix 
(Cerner). 

 

 
 
 
 

Next, follow the prompts to change your 
password. 

 
 
 
 
 

CCBH Password 
You are prompted by the system to change your CCBH password every 90 days. 
However, if you feel that someone has learned your password, for security reasons you 
should change it immediately. There are two ways to do this: 

External View 
From the External View, go to the “Access” tab and 
select the “Change Password” option. Follow the 
prompts to change your password. 

 
 
 

Clinician’s Homepage 

From the Clinician’s Homepage, go to the 
File Tab. Select the “Security” menu, and 
then select the “Change Password” 
option. Follow the prompts to change 
your password. 
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LOCK CCBH SESSION 
For security reasons, the expectation is that you will lock your CCBH session any time 
you step away from your computer. There are two ways to do this. 

 
Clinician’s Homepage 

From the Clinician’s Homepage, go to the “File Tab” and select the “Security” drop down 
menu, then select “Lock Session” button. 

 

External View 
 

From the External View, go to the “Access” tab and select the “Lock Session” option. 
 

 
 

You will be prompted to enter your password to unlock the session. 
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EXITING THE APPLICATION 
 

EXITING CCBH: To make sure you do not accidentally create a “ghost session” 
and lock yourself out of accessing CCBH, you must exit in the following manner: 

Clinician’s Homepage 
 

o Go to the “File Tab” menu in the top left-hand corner of your screen. 
o Select the “Exit Application” option. 

 

 
External View 

 

o Go to the “File” menu in the top left-hand corner of your screen. 
o Select the “Exit” option. 
o Repeat this step for any open external view window. 

 

 
You risk being locked out of CCBH if you do not exit in the manner described 
above! 
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CLINICIAN’S HOMEPAGE PREFERENCES 
How to setup and save preferences 

Accessing Preferences: 
 

 
A- From the “File Tab” 
B- Select the “Preferences” icon 

This feature allows you to set the Assessments that you use most frequently as 
preferences for easy access. 

Preferences for New Assessments: 

o Select the plus sign next to “New Assessments.” 
o Click “Commonly Performed Assessments” 
o Click “Add” 
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1) Select the assessment(s) you commonly perform. To select multiple 
assessments, hold down the “control” key as you click with the mouse. 
2) Once you have selected your preferred assessments, click the “Select” button. 

 
 

You will see your selections. 
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Saving Preferences: 
 

 
 

You have 3 options: 
 

Save: 
• Click the “Save” icon. This will save settings only. 

 
Save and Close: 

• Click the “Save and Close” icon. This will save your selections and take you back 
to the Clinician’s Homepage. 

 
Close Panel: 

• WARNING: If you click the “Close Panel” icon without saving, all of your 
preferences will need to be reset. 

 
 

Note: These preferences will not transfer from your TRAIN account to LIVE. They 
must be setup in LIVE too. 
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CLINICIAN’S HOMEPAGE TERMINOLOGY 
Identifying Terms Used on the Clinician’s Homepage 

 
Clinician’s Homepage: 
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status 
at a glance. 

 
File Tab: 
It can be used to exit the application, set preferences, access the external view, or see 
recently opened views. 

 

 
Tabs: 
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage. 

 
• There are four tabs: “File”, “Home”, “Client”, and “View.” 

 
 
 

Note: The “Client” tab will only be available if a client has been selected. 
 
 

Buttons: 
 

• The “Buttons” are individual selections that can be clicked on to perform various 
functions. 
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Ribbon: 
 

• The “Ribbon” is an object that is comprised of various buttons. 
 

 
Staff Panel: 
The Staff Panel automatically launches when the Clinician’s Homepage is opened. 

 

 
You will see your name as well as your job title listed. If you believe that the job title is 
incorrect, you must complete a new ARF form and submit it to the MH MIS Unit for 
correction. 

 
 

Caseload: 
 
 

The Staff Panel defaults to show your caseload. 
These are the clients who have been assigned 
to you. You can always return to your caseload 
by selecting the Caseload pane at the bottom of 
the screen: 
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CLIENT SEARCH 
 

Searching for a Client Who Is In Your Caseload: 
 

• On the Clinician’s Homepage “Home” tab, under “Caseload”, double click on the 
name of the client. 

• This action opens up the “Client Panel” where you can find information about 
your client. 

 

 
Searching a Client Who Is Not In Your Caseload: 

 
o Select the “Client Search” button 

 

 
o The “Client Lookup” window will open 

 

There are several different ways to search for a client from this window: 
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o By “Sort Name”: Enter the client’s sort name in the LAST NAME, FIRST NAME 
format, then select the “Search” button. (The “Sort Name” is the client’s name as 
formatted when first entered into the CCBH system): 

 

o If the Sort Name you’ve entered is in the system, it will be displayed in the “Client 
Search Results” area, as in this screen shot which exemplifies a search done for 
fictional client sort name, “PIE, APPLE”: 

 

o If the Sort Name you entered is not in the system, you will receive the following 
stop message: 

 

o This does not mean that the client is not in CCBH. Rather, you may not have 
entered the sort name exactly as it was formatted when the client’s information 
was first entered into the CCBH system. For this reason, you should search by 
other criteria such as: 
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Note: Before beginning another type of search, select the “Clear” button to 
reset the search criteria. 

 
o In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling 

and in ALL CAPS). 
o If client is found with that name, double check SSN. 

o Search by SSN. 
o Search by Alias. 

o If match found, open the Demographic form on client and double check 
DOB, address, SSN. 

o Check 3rd Party information to see if client has the same Medi-Cal (BIC, 
CIN) number. 

o If it is unclear which is the first name or the last name, enter the other position of 
names in Alias – e.g., Bubble Gum entered into CCI as GUM, BUBBLE may be 
entered into Alias as BUBBLE, GUM. 

 

 Note: When searching use all capital letters, these fields are case sensitive. 

o You can now search by one or more of the other criteria fields (Last, First, DOB, 
Alias Last, First, Sex, Case Number). Select the “Search” button. 

 
 
 
 
 
 
 
 

Note: If you search by data that is common in the system (such as conducting 
a search only by a common first name) you will receive the following warning 
screen. This allows you the option to either continue with or cancel the search. 
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Additional Client Search Feature 

o The “Thru” field, in conjunction with the “DOB” field allows you to search for 
clients within a particular date range. For example, if the DOB is approximately 
3/10/1964 and you enter 3/08/1964 in the “DOB” field and 3/12/1964 in the “Thru” 
field, all clients in the system who have that dates of birth in that date range will 
be displayed in the “Client Search Results” window. 

 Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find clients born only on that date. 
 

 
NOTES 
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RESTORE SYSTEM DEFAULTS 
 

If the layout becomes distorted, or the panes have disappeared, select “Restore Panel 
Layout” (under the Layout and Filters button on the Home tab). This will restore the 
layout to what it was when you first logged in. 

 
 

Select “Restore Panel Filters” (under the Layout and Filters button on the Home tab) to 
bring all the Filters back to their default settings, if desired. 

 

 
NOTES 
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ADDING NEW ASSESSMENTS 

• Access the desired client. 
• A “Client” tab will open with additional buttons listed within the ribbon. 
• The Client Panel will launch on the bottom portion of your screen. The name of 

the client will display in the client name box. 

Note: A client name must be displayed in the “Client Panel” to have the “Client” tab 
accessible. 

 

 
 

New Assessment Button: 
 

• The New Assessment button will be displayed in the “Client” tab ribbon. 
 

 
Note: The new assessment button is segmented in two parts. The upper portion 
of the button is a list of all assessments available for entry. The lower portion 
consists of assessments that have been established as “New Assessments” in 
your “Preferences”. 

 
To see a complete list of assessments: 

 
• Click on the top portion of the “New Assessments” button. 
• The “New Assessment Lookup” window displays. 
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Dating the Assessment: 
 

• Place the desired date in 
the date field. 

• Refer to the “GUIDELINES 
FOR DATES IN CCBH”. 

 
• Press the “Save” button. 

This will launch the 
assessment for data entry. 

• Search for the desired 
assessment by using the scroll 
bar on the right side of the list. 

• Highlight the assessment you 
wish to launch. 

• Click “Select”. 
• The system will open the 

external view and the selected 
assessment to begin data entry. 

 

Note: Double clicking on the 
assessment will also launch the 
desired assessment. 

 
. 

 
 
 
 
 
 
 
 

Note: Correct entry of the date is essential. Once the date is entered in the 
above field, it cannot be altered. 
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GUIDELINES FOR DATES IN CCBH 
 

Assessment Date: 
 

When adding an assessment, the system will require the entry of a date when opening 
the form for data entry. This is called the assessment date. 

 

 
 
 

The assessment date determines the date the assessment is sorted in the look up 
window. The assessment date must match the service date that is claimed in the 
system. Progress note documentation will need to support the service claimed. When 
an assessment service takes more than one session to complete, multiple service dates 
claimed must be indicated in each progress note for each service date. However, the 
assessment date entered in the MIS will remain the initial assessment service date. 
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Signature Date: 
 

Signature dates may be different than the assessment date, which is necessary at times 
(i.e. when a co-signature is necessary but the staff is out of the office). 

 

 
 

Note: Co-signatures must be completed within timelines. 
 

Final Approve Date: 
 

The final approval date may be different than the assessment date and/or signature 
dates. The final approval date is the date that the assessment is considered active and 
complete. This date will also drive the timelines for documentation reviews. 
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ELECTRONIC SIGNATURE GUIDELINES 
 

• Certain assessments in CCBH can be final approved by any clinical staff who 
have required system access, such as the Safety Alert or the Demographic 
Form. Anyone can complete the assessment and final approve as themselves, 
without a co-signature. 

 
• To final approve the Safety Alerts and Demographic Form 

 
1) Make sure all software required fields have been addressed. 

(a) To check, click the 
“Perform Validation 
Check” button at the 
top of the window. A 
screen will appear at 
the center of your screen with a list of fields to be 
addressed, if any. If all required fields have been 
addressed, you will not see a screen appear. When 
ready, proceed with the final approval step for the 
assessment. 

 
2) Click the 

“Final 
Approve” 
button 
located at 
the top of 
the window. 

 
 

3) Enter your CCBH 
password when 
prompted. 
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• Some assessments contain 
credential restricted signatures. 
For instance, there are three 
credential restricted signature 
lines located in the “Validations” 
pane of the Diagnosis Form, and 
two signature lines on the BHAs. 

 
• Your license type or credential will 

determine how you address each signature line. 
 
 

Staff Who Require a Co-Signature: 
 

1. Sequence 1 (Staff Requiring Co-Signature) - Left click and select “Electronically 
Sign.” 
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2. Enter your CCBH password when prompted. 
 

3. Sequence 2 (Staff Comp/Accept Assessment) – Left click and select “Assign 
Signatory.” 

 

 
4. Find your supervisor by name or staff ID. Highlight their name and choose 

“Select” at the top. 
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5. Sequence 3 (Staff Entering Information), if applicable – Left click and select “Delete.” 
 

 
6. Click “Save and Close” located at the top of the window. After you click “Save 

and Close,” you return to the Clinician’s Homepage. The name of the client will 
display on the Notifications list on your Clinician’s Homepage and on the 
Homepage of the approved signer until the assessment is co-signed and final 
approved. 

 

 
Staff Who Final Approve (or Co-Sign) Assessments For Others: 

 
1. Find the client on your Notifications list on the Clinician’s Homepage. 

2. Access the assessment and review. The person for whom you are co-signing 
should have already completed Sequence 1 signature line and deleted Sequence 
3. 

3. Sequence 2 (Staff Comp/Accept Assessment) – Left click and select 
“Electronically Sign.” 
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4. Enter your CCBH password when prompted. 
 

 
 

5. Click “Final Approve” located at the top of the window. 
 

 
REMINDER: Co-signatures and final approval of assessments should be done as soon 
as possible. 

 
 

PLEASE REMEMBER: 

 Passwords may NEVER be shared as this constitutes a 
breach of security and HIPAA violation. 

 
 

NOTES 
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Saved forms: 

VIEWING ASSESSMENTS 

• Are “saved” but not final approved. 
• Can be edited or deleted by anyone who has access to that client’s forms. 
• Will hold up the work flow as they prevent adding another form in which any fields 

are shared. 
Lock it down by Final Approving to protect your work!! 

 

How to open a saved assessment: 
• Select a client and open the “Client Panel”. Next, click the “Assessments” pane. 
• A list of assessments will display. The assessment that is not final approved will 

not have a check under the Final Approved status (F/A). 
• Double click the assessment. The selected assessment will open for data 

entry and completion. 
 

VIEWING FINAL APPROVED ASSESSMENTS 
• Select a client and open the “Client Panel”. 
• Next, click the “Assessments” pane. 
• A list of assessments will display. The assessments that are final approved 

will have a check under the Final approved status (F/A). 
• Double click the assessment. The selected assessment will open for review. 
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PRINT TO SCREEN 
 

Note: Before printing a hard copy, always print to screen first to verify whether 
printing is truly necessary. 

 
• Click the “Print” button. 

 

 
• Click on the down arrow to the right of the “Printer” field, click “Print Preview”, 

and click the “Print” button. 
 

 
 
 

It will take a few moments to process the command. Wait 
until the following message disappears. 

 
 
 

A copy displays on the screen. Pay attention to the total number of pages before 
deciding to print a physical copy. 
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deciding to print a physical copy. 
 
 

Icons 
 

You will find icons across the top of the print screen which will allow navigation through 
the copy. 

 

 Prints a physical copy. 

 Emails a copy. DO NOT use this feature, as it is a breach in confidentiality. 

 Displays the default size of the copy. 

Shrinks the copy down to 25% of the default size. 

Zooms in by 50% each time the icon is clicked. 

 Zooms out by 25% each time the icon is clicked. 
 Navigates directly to the first page. 

 
 Navigates back one page. 
 Navigates forward one page. 

 Navigates directly to the last page. 

 Displays keyboard commands for navigating through the copy. 
 Displays the details of the software product. 

 
• Closes out of "Print to Screen” and returns to the original view. 
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Support Desk Contact Information 
sdhelpdesk@optum.com 

1-800-834-3792 
 

Monday through Friday (E-mail) 

Monday through Friday (Telephone) 

 
 

Weekends (Telephone) 
Hours Services 

4:30 am to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

* By definition, a system outage affects multiple users. Examples includewhen: 
-The system does not respond and appears to be frozen 
-No data can be entered or viewed 

 
Support Desk Suggestions 

 
• Please consult with your program manager and your resource packet prior to 

contacting the Support Desk. 
 

• When calling for a password reset on weekdays between 4:30-6a or 6-11p, or 
calling weekends between 4:30a-11p, you must leave a message. Include your 
name, CCBH staff ID, phone number and the reason for your call. 

 
• You may be given a ticket/tracking number if you call between 6:00a and 6:00p 

Monday through Friday. Remember to keep this number for future reference. 
 

Additional Contacts 
 

Questions Where To Go 
Clinical Documentation Questions Documentation Manual/Your Program Manager 
Duplicate Clients and 
Name/DOB/Gender/SSN Changes 

Complete Form BHS-025 and 
Call Medical Records: 619-692-5700 x 3 

Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612 Fax- 858-467-9682 
Online User Manuals and Forms www.optumsandiego.com 
Service Codes CCBH (Anasazi) User Manual/QM Unit 

 

Hours Services 
6:00 am to 6:00 pm All services except password resets or any service involving PHI 

 
Hours Services 

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages* 
6:00 am to 6:00 pm All services 
6:00 pm to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

 

mailto:sdhelpdesk@optum.com
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